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AVIiva Program Instructions

Click on the menus in the image below for help.
Use pop-up help on the actual program interface for help on the controls.

Starting the Program
AVIiva can be started several ways:

1. By double-clicking on the program icon or selecting the program from the Start / Programs menu 
on the task bar.

2. By dragging one or more video file icons over top of the program icon.    Note that when you do 
this, the path and filenames will have the shortened DOS values.

3. If you have associated the AVI extension with AVIiva, you can simply double-click on a video file 
icon.    If more than one file is selected during double-clicking, then a separate copy of AVIiva will 
start for each file.

To associate AVIiva with the AVI extension, open Windows Explorer, choose the View/Options menu, 
then the File Types tab.    If the AVI type is already on the list, select it for editing, if not then create a 
New Type.    Create a Play action if not already there and then edit it.    Click on the Browse button 
and navigate to the AVIiva executable and select it.    The path and name of AVIiva will be entered 
into the Application used to perform action field.    Edit this field by adding a space and "%1" to the 
end of the field.    Press OK and then the Change Icon button.    Select the AVIiva icon if there or 
press Browse to look for the AVIiva program again.    Select the program and its icon will appear for 
selection.    Press OK, then Close, then Close again to finalize changes.

4. If you have previously saved a settings file (see below), it will have a .AVIiva extension.    By 
associating the .AVIiva extension with the AVIiva program, you can double-click on the settings file 
icon, and AVIiva will load and in turn load the settings file.

You can associate the .AVIiva extension the same way as described above for the .AVI extension.    
However, do not add the space and "%1" to the action field.    If you put a /h at the end of the 
program path and filename in the action field (make sure they are outside any quotation marks), then



the control panel will hide itself upon loading the AVIiva settings file.    If you put a /p at the end of the 
program path and filename in the action field (again, outside quotation marks), then any files 
selected for playback in the AVIiva settings file will automatically start playing.    You can put both a /h
and a /p to hide the control panel and start playing the video files.    In this case the action field may 
look something like this:

"C:\Program Files\AVIiva\AVIiva.exe" /h /p

IMPORTANT: Make sure there are no spaces after the /p.

NOTE: You cannot open an AVIiva settings file by dragging it to the AVIiva program icon.    This is due
to Windows using only the old DOS 8.3 naming convention when dragging files.    AVIiva checks for a
.AVIiva extension, but will not find it in the DOS version of the filename.

Using the Program
Once the program is loaded, you will see the interface shown above.    I will not discuss how to use 
the controls here.    You can obtain pop-up help in the program proper by first clicking on the ? in the 
menu bar and then clicking on a control.

To learn about the menu items, click on a menu item in the above picture.

Below I discuss various general topics related to AVIiva's use.

Adding Videos to the File List
AVIiva can only play AVI files.

Video files can be added to the file list as mentioned in the "Starting the Program" section above.    If 
you started AVIiva by double-clicking its icon, then it will load with no video files in its file list.

To add files to an empty list or add additional files to an existing list, select Add Files... from the File 
menu.    A file dialog box will appear allowing you to select multiple files.    Upon clicking the OK 
button, all the selected files will be added to the file list.

Alternatively, files can be dragged from Windows Explorer to the file list box.    This includes video 
files as well as .AVIiva settings files.

Using and Manipulating the File List
When a file is selected from the list by clicking, it will load and the first frame will be displayed.    (If 
more than one file is selected in the list, only the top-most selected file is displayed.)

Once a video file is open, it can be navigated using the controls and menus on the program's 
interface.    You can move to any frame using the slider, jump to the start or end frames, step 
forwards or backwards, play in reverse, play full screen, loop, sequence selected files, turn sound on 
or off, adjust the volume, etc.

To play several videos in sequence, select all the videos to be played from the file list, make sure the 
Settings / Sequence Files menu item is checked, and press the play button.    If the Settings / Loop 
Files menu item is checked, the sequence will repeat after all the selected videos have been played.

While a video file is open, its frame rate, step size, seek mode, IN frame, OUT frame, sound mode, 
volume, window size, and aspect ratio setting can be adjusted.    Once adjusted, this information will 



remain with the file even if it is moved on the list.    Also, this information will be stored in a saved 
settings file.    This allows you to create a custom presentation that can be recreated easily at a later 
time.

If you would like to see what the current settings are for each file in the list, select Show File Settings 
from the Windows menu.    Another window will open and display the information in a table.    This 
information cannot be edited from this window.

Information about the format of a .AVIiva settings file

Manipulating the Video Control Window
With the addition of the file list box and list manipulation buttons, the AVIiva window has become 
quite big.    Although you can make the control window disappear (see next section), sometimes you 
might want it visible, but smaller.    By double-clicking in a blank area of the window (where no 
controls are located), the bottom part of the window, containing the list box and buttons, will collapse. 
Double-clicking again will make it full size again.    This feature can also be activated using the Full 
Size Control Panel menu item on the Window menu.

Manipulating the Video Display Window
A video file is originally displayed inside a window.    However, if you check the Settings / Show Full 
Screen menu item, the video will appear full screen (using the screen's current resolution) with no 
borders.

The windowed display can be resized by dragging the sides or corners of the window.    When the 
window is resized, one of two things will happen.    If the Settings / Constant Aspect Ratio 
(width:height ratio) menu item is not checked, then the video image will be stretched to fill the 
window.    If the menu item is checked, then the video image will be made as large as possible while 
still maintaining the aspect ratio of the video.    The aspect ratio option also affects the way the video 
is displayed in full screen mode.

When you click on a video image, the control panel window will disappear.    This makes it easy to get
it out of the way if it is covering the video image.    To make the control panel appear again, click once
more on the video image.

For a windowed video display, double-clicking on the video image will resize the window to its 
original size.

The close button on the windowed video display is active.    You can close the video by clicking on it.  
You will asked to verify your actions.

Video Display Window Keyboard and Status Bar
When the video display window (just the windowed display, not the full screen display) has the focus,
key strokes can be used to manipulate all aspects of playing back videos.    For a complete list of 
these keyboard commands, see the Keyboard and Status Bar Shortcuts help window.

In order to help you remember what the current settings are, a status bar appears at the bottom of 
the windowed AVI display.    It contains panels that each display a particular setting.    For instance, 
the first panel displays "Seek" if playback is currently set to seek mode or "^Seek" if not in seek 
mode.    Several of the other settings are also on-off type settings.    The ^ symbol always means that 
the setting is currently off.    Other settings, like the frame rate, step size, in frame, and out frame 



actually show a number such as "FR=15" if the frame rate is currently 15.

Any of the settings shown in the status bar can be changed by clicking on the appropriate panel.    
See the Keyboard and Status Bar Shortcuts help window for details.

Forward Playback
If you are playing a video normally with a step rate of one, then frames may be skipped in an attempt
to maintain the designated frame rate.    If it is more important to see each frame of the video than to 
maintain the selected frame rate, then make sure the Settings / Seek Play menu item is selected.    
Using seek play, each frame will be displayed even if the frame rate cannot be maintained.    When 
the step rate is greater than one, Seek Play mode will automatically be selected since regular play 
mode is not available in this case.

Reverse Playback
When playing a video backwards (Reverse Play checked) in regular mode (Seek Play not checked), 
then only keyframes will be displayed.    Thus, if every fifth frame is a keyframe, then only every fifth 
frame will be displayed.    In order to see all frames, select Seek Play mode.    With this setting, you 
may notice the video flashing.    This is what happens when some of the frames in the video are not 
keyframes.    Typically, a video file will only have keyframes, which contain the complete information 
about the frame, ever so many frames (usually every 5-10 frames).    All of the frames between these 
keyframes only store information about the differences from the previous frame.    Thus, when playing
or stepping in reverse to a non-keyframe, the image has to be rebuilt from the previous keyframe, 
which means you will see several frames quickly rebuild causing the flashing.    If it is important that 
the video play smoothly in reverse, save the video such that every frame is a keyframe.    This will 
make the video file quite a bit larger, but it will be much smoother playing backwards.    Be aware, 
however, that the larger file will not play as fast forwards.    As usual, there are tradeoffs and you 
must decide what is most important to you for a particular video.

Closing the Program
To close AVIiva, select Exit from the File menu or click on the close button (the button in the upper-
right-hand corner of the window with an X in it).    You will be asked to verify your actions.



Format of a Settings File
Here is a sample settings file.    It has changed from versions of AVIiva earlier than v3.00 and is no 
longer compatible with the older versions.    However, you can probably modify existing .AVIiva files 
with an editor after looking at the changes to this file below.

[FILES]
C:\MyVideos\S01b.avi,8,1,False,0,96,True,500,9600,7200,True,False
C:\MyVideos\s01.avi,-/8,1,False,10,77,False,500,9600,7200,True,True
C:\MyVideos\acf2wpr.avi,NONE,0,False,0,0,True,700,0,0,False,False

[SETTINGS]
Sequence=True
Loop=True
FullScreen=False
ConstantSettings=False
ConstantDisplay=False
ControlTop=4605
ControlLeft=5025
ControlHeight=3690
ControlState=0
ControlVisible=True
DisplayTop=30
DisplayLeft=0
DisplayState=0

The [FILES] section contains the list of files in the file list box with some additional comma delimited 
information.    Each line contains the following information:

filename, frame rate, step size, seek mode (true or false), IN frame, OUT frame, sound (true or 
false), volume (0-1000), window width (in twips, 15 twips/pixels), window height (in twips), constant 
aspect ratio (True or False), selected (True = file is selected, False = file is not selected)

Some of the settings may be zero.    This is okay.    Some settings can only be filled in when the file is 
opened for the first time.    Thus, when you see settings that are zero for a file, you know that that file 
was never opened before the settings file was saved.

The [SETTINGS] section contains information about the settings of all the other controls and menus 
on the AVIiva interface.    Since the name of the control appears in the list itself, these items are self-
explanatory.    The items that appear in this list are dependent upon several factors such as: 1) 
whether or not there are any files in the file list, 2) whether any files are selected in the list, and 3) 
whether or not the Use Constant Settings or the Use Constant Display menu items are checked.



Keyboard and Status Bar Shortcuts for AVIiva
When the video window (either small or full screen) has the focus (e.g.- is the active window), 
keyboard commands can be used to control all aspects of playing videos.    In order to help you keep 
up with what the current settings are, a status bar at the bottom of the AVI window (not available on 
the full screen display for obvious reasons) shows 11 of the current settings.

Below is a concise compilation of the keyboard commands.    Also, the status bar can be used to 
change settings by clicking on the appropriate panels.    The way to do this also appears below.

Start and Pause Playback of Video
Space Bar (toggles)

Step Forward or Backwards through Video
Right Arrow or Left Arrow keys

Go to Beginning or End of Video
Home or End keys

Go to Previous or Next Video
Up Arrow or Down Arrow keys
Goes to previous or next file in the file list whether it is selected or not.

Turn Sound On and Off and Change Volume
Shift-V, Ctrl-V, and V keys
Shift-V toggles sound on and off.    Ctrl-V increases volume, V decreases volume.

Reset, Increase, or Decrease Frame Rate
Shift-F, Ctrl-F, and F keys
Shift-F resets the frame rate of the video to its original value.    Ctrl-F increases the frame rate, F 
decreases the frame rate.    (Alternatively: Shift-Click, Ctrl-Click, or Click the panel on the AVI window
status bar that contains "FR=".)

Reset, Increase, or Decrease Step Size
Shift-S, Ctrl-S, and S keys
Shift-S resets the step size of the video to one.    Ctrl-S increases the step rate, S decreases the step
rate.    (Alternatively: Shift-Click, Ctrl-Click, or Click the panel on the AVI window status bar that 
contains "SS=".)



Set or Reset IN Frame
I and Shift-I keys
I sets the IN frame to the current frame.    Shift-I resets the IN frame to zero.    (Alternatively: Click or 
Shift-Click the panel on the AVI window status bar that contains "IN=".)

Set or Reset OUT Frame
O and Shift-O keys
O sets the OUT frame to the current frame.    Shift-O resets the OUT frame to the last frame in the 
video.    (Alternatively: Click or Shift-Click the panel on the AVI window status bar that contains 
"OUT=".)

Turn Seek Mode On or Off
K key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "Seek".)

Turn Reverse Play Mode On or Off
R key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "Rev".)

Turn Sequencing Mode On or Off
Q key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "Seq".)

Turn Looping Mode On or Off
L key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "Loop".)

Turn Full Screen Mode On or Off
W key (toggles)

Turn Constant Aspect Ratio Mode On or Off
A key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "AR".)

Turn Constant Settings Mode On or Off
T key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "CSet".)



Turn Constant Display Mode On or Off
D key (toggles)
(Alternatively: Click the panel on the AVI window status bar that contains "CDisp".)

Save Settings File As...
F10
This is useful is you want to save the settings file with the control window either minimized or hidden.



AVIiva Features History

Changes to v3.11
· A status bar now appears at the bottom of the AVI window (but not the full screen display) that 

contains 11 panels.    Each panel indicates the state of a particular setting.    The settings can be 
changed by clicking on the appropriate panel.

· Corrected a problem with the IN frame and OUT frame being assigned incorrectly under certain 
circumstances when running under Windows 95 with Internet Explorer 4.0 installed.

· Corrected a problem when reading video files with an embedded frame rate of less than 1 fps.

Changes to v3.10
· All aspects of video playback can now be controlled via the keyboard while the video window 

itself has the focus.    This allows playback to be controlled without the control panel having to be 
visible at all.

· The position, size, state, and visibility of the control window and video window are now saved 
in .AVIiva settings files.    This allows the user to reposition these windows to a suitable location 
for the presentation and then have them automatically reappear that way when a settings file is 
loaded.

· A Remove All button was added to the control window.    This allows all the files in the file list to 
be removed quickly without having to select all of them first.

Changes to v3.00
· Can now handle a longer list of files when adding multiple files from the Add Files menu item.
· Moved most of the settings from check boxes in the program window to the Settings menu on the

menu bar.
· Added a slider for changing the frame rate of a video.    Rates vary from -80 to 80 frames per 

second.    (Actual speeds depend on complexity of the video and the speed of the computer.)    
Near the center of the frame rate slider, fractional rates are available.    Thus, /4 means 1/4 frame
per second or rather 4 seconds per frame.    Fractional rates vary from 2 to 11 seconds per frame
in either forward or reverse direction.

· Added a slider for changing the step size of a video.    Sizes vary from 1 to the number of frames 
in the video.

· The text boxes displaying the frame rate and step size can no longer be edited directly, but 
various keys can be used to raise and lower their values just as you can with the sliders.

· OLE drag and drop can now be used to add files to the file list by dragging them from Windows 
Explorer to the file list box.    Settings files can also be dropped in the file list box.

· The custom settings currently associated with the files in the list can now be viewed in table form
by selecting the Window / Show File Settings menu item.

· Individual files can be selected for reverse play mode such that some files play forward and other
play backwards (as opposed to all files playing in the same direction).    Because of this, the files 
always play from the top down (as opposed to playing from the bottom up in reverse mode in 
previous versions of AVIiva).

· Additional settings can be specified for each individual file such as sound on/off, volume, and 
window size.    These settings are saved in the settings file.

· Due to changes mentioned above, the settings files for version 3.00 of AVIiva are incompatible 
with earlier versions of AVIiva.    Sorry about this.    I tried to maintain compatibility but there were 
just too many changes necessary.



· When a .AVIiva settings file is loaded, the files are now appended to the file list.    In earlier 
versions, loading a settings file caused all files in the file list to be removed first.

· Fixed a few bugs with the Up, Down, Top, and Bottom buttons.

Changes to v2.11
· Added the ability to hide the control panel when loading an AVIiva settings file by double-clicking 

the file in Explorer.
· Added the ability to automatically start playing videos when loading an AVIiva settings file by 

double-clicking the file in Explorer.
· Corrected a minor bug with loading the help file.

Changes to v2.10
· There was a problem when starting AVIiva by double-clicking a video file or dragging video files 

over top of its icon.    Both problems were corrected.

Changes to v2.00 Release
· The control panel can be minimized without the video window going away.    If you click inside the

video window, the control panel will be unminimized just like it is made visible if hidden.
· If the control panel is hidden or minimized, it will no longer reappear when one video finishes and

the next one in sequence begins to play.

Changes to v2.00 Beta 2
· More than one video file can be selected.    The names of these files are added to a list.    The 

order of the files can be adjusted.    By highlighting files in the list, they can be played in 
sequence.

· There is an option for playing all files using the current playback settings regardless of the 
settings in the files themselves.

· There is an option for playing all files using the current display settings regardless of the settings 
in the files themselves.

· The playback settings for each file in the list can be changed.    These changes will be 
remembered as the files are reordered and played.

· The file list and the settings for each file can be saved to and then retrieved at a later time.    This 
is a great aid when you want ot set up a presentation.

· Seek play mode can now be selected even when the step rate is one.    This mode ensures that 
all frames in the file will be shown even if the selected frame rate cannot be maintained.    (With 
regular play mode, frames may be skipped to maintain the selected frame rate.)

· Videos can be played backwards in regular mode.    The disadvantage of this mode is that only 
keyframes are displayed.    Thus, if every fifth frame is a keyframe, then only every fifth frame will
be displayed.

· The volume of video files containing sound can be adjusted using a slider control.
· A menu bar was added because the additional features of v2.00 was making for a cluttered 

interface.    However, adding the menu bar allowed for some hidden features of the program to be
explicitly available.

· The pop-up help button was eliminated and replaced with a pop-up help menu item that appears 
as a question mark in the menu bar.

· The pause and stop buttons were eliminated from the VCR control panel.    When the play button 
is pressed to start playing a video, it turns into a pause button.    When the pause button is 
pressed to stop playing a video, it turns back into a play button.



· The check boxes now have verbose labels so it is easier to determine what they do.



AVIiva v3.11 Payment Instructions
AVI interactive video application is a product of RKA Productions and was written by Randy Finch.    
Here is contact information:

Randy Finch
RKA Productions
122 West Oak Hill Dr.
Florence, AL    35633-1013
Email: rcfinch@hiwaay.net
HomePage: http://fly.hiwaay.net/~rcfinch

Send comments and suggestions to my Email address.

AVIiva v3.11 is a free upgrade to all registered users of earlier versions of AVIiva.    To become a 
registered user, print this form and send it in with your payment.    If you give me your Email address, 
I will let you know when updates to the program are available.

Alternatively, you can register AVIiva with a credit card via secure Web transaction using Register 
Now!    Go to my web site (listed above) and follow the link to my PC Programs page.    There will be 
a button that links you to the registration site.

YES, I want to help support the author of AVIiva and encourage him to continue updating it.    I have 
enclosed my $20 (or more) shareware fee.    Please send only cash, check, or money order when 
registering by mail.

If you are a registered user of a previous version of AVIiva,    this upgrade is free.

NAME: _______________________________________________________

ADDRESS: ___________________________________________________

CITY, STATE, ZIP: _____________________________________________

EMAIL: _______________________________________________________



Troubleshooting

The VCR Panel Flashes When Playing in Reverse and the Video Cannot Be Stopped
· When a video file is playing backwards in regular mode (not seek mode), only the key frames are

shown.    If you have a video file with only a very few key frames (this usually occurs with very 
short videos) and looping is turned on, it could be that the file is shifting between playing and 
stopping so fast that the VCR panel will flash and the program cannot be stopped.    You can try 
pressing CTRL-Break many times in succession.    If this does not work, you will probably have to
press CTRL-ALT-DEL, click on AVIiva in the task list, and then press the End Task button.    This 
will force AVIiva to stop.    Make a mental note not to play this file again in this way.    It should 
play okay if looping is off or seek play mode is on.

An Error Occurs When Loading an AVIiva Settings File
· You cannot load an AVIiva settings file by dragging it to the AVIiva program icon because 

Windows converts path and filenames to their DOS 8.3 equivalents when using this method.    
Therefore, the filename will no longer have a .AVIiva extension.

· Make sure there are no spaces at the end of the action line for the file type association.    For 
more information, see the Program Instructions.

Video Stops Playing Unexpectedly
· If video playback stops at the end of the last selected video in the list and you are expecting it to 

loop back to the first video in the list, check to make sure the Settings / Loop Files menu item is 
checked.    You may think this simplistic, but there have been many times during testing AVIiva 
that I forgot to turn on looping and then was at a loss as to why the video playback stopped.

· Due to some timing issues that take place when one video ends and another begins, you might 
experience what seems to be a program hangup, but really isn't.    One video ends, but the next 
one in sequence does not start.    However, the pause button never turns back to a play button.    
This prevents you from starting the playback again.    The fastest way to correct this is to unselect
all the files in the file list and then reselect the ones you want to play.    The play button will then 
reappear and playback can proceed.    I made a change to the program that seems to have 
corrected this problem, but I wanted you to be aware of it.

· I had one user report that when playing a sequence of very large video files (~70 MB each), the 
program would stop in the middle of a random file at a random place after about 25 minutes.    I 
have not been able to duplicate this problem using any files I have up to about 30 MB.

AVIiva Won't Play My Video File
· If the file is not an AVI file or it is a corrupted AVI file, it cannot be played.    Also, you must have 

the right codec (compression / decompression) files installed to decompress the AVI file.    Most 
people have the RLE, Microsoft Video, Indeo, and Cinepak codecs on their system.    However, 
any codec can be used within an AVI file.    If you try to play a video for which you do not have the
right codec, a message something like this appears: "mmsystem006: There is no driver installed 
on your system."    The only way to solve this is to find out what codec was used and install it.    A 
way to get a clue is to right click on the AVI file in Windows Explorer, select Properties, then the 
Details tab.    The last piece of information about the Video format is usually the compression 
type.

The Control Panel Won't Come Back
· Sometimes when videos are being played in full screen mode and the control panel is not visible,

you can click on the video window and the control panel will not reappear.    Usually clicking a 



second time will make it reappear.

The Color Palette for the Video is Incorrect
· When running AVIiva with a 256-color display, the video's color palette can sometimes get 

messed up when another program has the focus.    When this happens, a simple click in the 
video display window should restore the proper palette.    However, I have run into many weird 
situations when working with palettes, so this may not work on your system.    If so, try playing 
the video to see if it will clear up.    As a last resort, the video may have to be opened again.

What Happened to the Help File?
· If you load files from a directory other than the AVIiva installation directory before using pop-up 

help, the program may have difficulty finding the help file.    When this happens, you will be given 
an option to find the help file yourself.    Just point to the help file in the installation directory.    You
should not have any further problems.

Where's the Pop-up Help?
· Pop-up help will not work on a control that is ghosted.
· In the past, there was a problem with some versions of mfc40.dll that caused the pop-up help for 

sliders and the MCI control to not work.    I have not run into this problem with newer versions of 
this file.    The version that was distributed with this software works fine.    However, if you have 
problems with these pop-up help items, you probably have a version of mfc40.dll that does not 
work.    However, you might not want to overwrite a newer version with the one distributed with 
AVIiva because it may cause other programs to quit working properly.    You can determine the 
version of a system file by going to the Windows\System directory in Windows Explorer, right 
clicking the file of interest, and choosing Properties from the pop-up menu.    Click on the Version 
tab to see the file version.



Sound Check Box
This check box is used to turn on the sound in the video file.    When this box is checked, 
sound will be played.    When this box is unchecked, sound will not be played.

Mouse:
Click in the box or on label to toggle the check box.

Keyboard:
When the check box has the focus, press the space bar to toggle the check box.



Bottom Button
Pressing this button causes all the selected files in the adjacent File List Box to be moved to 
the bottom of the list, maintaining their original order.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Down Button
Pressing this button causes all the selected files in the adjacent File List Box to be moved 
down one position in the list.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Frame IN Set Button
This button is used to set and reset the IN (or start) frame for the video file.    The number on 
the button reflects the current IN frame (initially zero).    A small left-pointing triangular tick 
mark also appears on the slider above at the appropriate location.

Mouse:
Click on the button to make the current frame the IN frame (if the current frame is less than the OUT 
frame).    Shift-click to reset the IN frame to zero.

Keyboard:
When the button has the focus, press the spacebar to make the current frame the IN frame (if the 
current frame is less than the OUT frame).    Press shift-space to reset the IN frame to zero.



Frame OUT Set Button
This button is used to set and reset the OUT (or end) frame for the video file.    The number on 
the button reflects the current OUT frame (initially the last frame of the video).    A small right-
pointing triangular tick mark also appears on the slider above at the appropriate location.

Mouse:
Click on the button to make the current frame the OUT frame (if the current frame is greater than the 
IN frame).    Shift-click to reset the OUT frame to the last frame of the video.

Keyboard:
When the button has the focus, press the spacebar to make the current frame the OUT frame (if the 
current frame is greater than the IN frame).    Press shift-space to reset the OUT frame to the last 
frame of the video.



Remove Button
Pressing this button causes all the selected files in the adjacent File List Box to be removed 
from the list.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Select All Button
Pressing this button causes all the files in the adjacent File List Box to be selected.    The top-
most file will become the current file.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Select None Button
Pressing this button causes all the files in the adjacent File List Box to be unselected and the 
current file will be closed.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Top Button
Pressing this button causes all the selected files in the adjacent File List Box to be moved to 
the top of the list, maintaining their original order.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



Up Button
Pressing this button causes all the selected files in the adjacent File List Box to be moved up 
one position in the list.

Mouse:
Click on the button.

Keyboard:
When the button has the focus, press the spacebar.



File Menu

Open Settings Menu
When this menu item is selected, a File Open Dialog Box will appear.    From there, a single file
with a .AVIiva extension can be selected.    (A file of this type can be saved by selecting the 
Save Settings As menu.)    By clicking on the OK button, the selected file will be opened and 
the settings will be applied to the program, replacing the current settings.    Any filenames in 
the settings file will be appended to the existing file list.    If you associate the .AVIiva 
extension with the AVIiva program, you can simply double click a .AVIiva file and AVIiva will 
run and in turn load the settings file.    (NOTE: A .AVIiva file cannot be dragged to the AVIiva 
program icon or a shortcut since drag and drop does not currently support long filenames.)

Mouse:
Click "File" on the menu bar and then select "Open Settings...".

Keyboard:
Press Ctrl-O or Press Alt-F for the File menu and then "O".

Save Settings Menu
When this menu item is selected, the current settings will be saved to a .AVIiva file using the 
same name as the last loaded or saved settings file.    If no .AVIiva file has been opened or 
saved, a File Save Dialog Box will appear, allowing you to enter a name.    See the Save 
Settings As menu for more details.

Mouse:
Click "File" on the menu bar and then select "Save Settings".

Keyboard:
Press Ctrl-S or Press Alt-F for the File menu and then "S".



Save Settings As Menu
When this menu item is selected, a File Save Dialog Box will appear, allowing you to enter a 
filename for saving the current settings.    The default extension for this file is .AVIiva.    This 
file will contain the names of all the files in the File List Box, which ones are selected, their 
frame and step rates, etc.    (See the main help text for more details.)    If no files are in the list, 
only the current settings will be saved.    A .AVIiva file can be retrieved using the Load 
Settings menu item.

Mouse:
Click "File" on the menu bar and then select "Save Settings As...".

Keyboard:
Press Ctrl-A or Press Alt-F for the File menu and then "A".

Add Files Menu
When this menu item is selected, a File Open Dialog Box will appear.    From there, multiple 
video files can be selected.    By clicking on the OK button, the selected files will be added to 
the File List Box.    (NOTE: Video files can also be added to the list by dragging the videos' 
icons over top of the AVIiva program icon or a shortcut to it.    Also, video files can be dragged
from the Windows Explorer window to the File List Box.)

Mouse:
Click "File" on the menu bar and then select "Add Files...".

Keyboard:
Press Alt-F for the File menu and then "F".

Exit Menu
When this menu item is selected, you will be prompted as to whether or not you really want to
exit the program.    If you respond with a Yes, the program will terminate.    Otherwise, the 
program will continue.

Mouse:
Click "File" on the menu bar and then select "Exit".    Alternatively, click on the Close button (X) in the 
title bar.

Keyboard:
Press Ctrl-X or Press Alt-F for the File menu and then "X".



Help Menu

Instructions and Ordering Menu
Selecting this menu item opens the help window and displays the Contents page of the 
program's help file.

Mouse:
Click "Help" on the menu bar and then select "Instructions and Ordering...".

Keyboard:
Press F1 or press Alt-H for the Help menu and then "I".

About AVIiva Menu
When this menu item is selected, a small window with information about the program will be 
displayed.    This window has a button that allows a help file to be displayed containing more 
information about running the program and sending in moola to help the author along in his 
programming endeavors.

Mouse:
Click "Help" on the menu bar and then select "About AVIiva...".

Keyboard:
Press Alt-H for the Help menu and then "A".



Current Frame Label
This label always contains the current frame number for the movie.    It will update while 
moving to a new frame by moving the slider above or pressing certain "VCR" buttons below.

Note: When playing a movie, this label may not be updated every frame change.    How often it
updates depends on the complexity of the movie and the speed of your computer.



Last Frame Label
This label always contains the last frame number for the movie.    It will update when a new 
video file is loaded.



Start Frame Label
This label shows the start frame number of the movie.    This number will always be zero.



File List Box
This list box contains all the files to be potentially played.    The box can be populated by 
chosing the File / Add Files menu item and then selecting multiple files from the dialog box.    
The selected files will be added to the current list of files.    Alternatively, an AVIiva file can be 
opened by selecting the File / Open Settings menu item.    Also, video files or settings files can
be dragged from Windows Explorer to the File List Box.    If only one file is selected, it will be 
the currently open file.    If more than one file is selected, the top-most file in the list will be 
opened.

Mouse:
Click on a file to make it the currently opened file.    Click-drag or click/shift-click to select multiple 
sequential filenames. Ctrl-click-drag to deselect multiple sequential filenames.    Ctrl-click to select or 
deselect multiple non-sequential files.

Keyboard:
When the list box has the focus, use the up or down arrow keys to open the file above or below the 
current file.    Use Page Up and Page Down to move through the list one page at a time.    Use the 
Home or End keys to open the first or last file in the list.    Using the Shift key in combination with 
these keys will select multiple files.



"VCR" Control Panel

Start Button: Used to reset the video to the current IN frame as specified by the Frame IN Set Button.

End Button: Used to reset the video to the current OUT frame as specified by the Frame OUT Set 
Button.

Play Button: Used to play the video.    If the Reverse Play menu item is checked, it will play 
backwards.    For step rates greater than one, the video will skip that number of frames as it plays.    
This button becomes a pause button while a file is playing.

Pause Button: Used to pause the video while it is playing.    This button becomes a play button after 
pausing a video.

StepBack Button: Used to step backwards in the video by the current step rate (see the Step Entry 
Field).

StepForward Button: Used to step forwards in the video by the current step rate (see the Step Entry 
Field).

Mouse:
Click on the appropriate button to carry out the actions described above.

Keyboard:
When the Control Panel has the focus, the left and right arrow keys will move the focus to the button 
on the left or right.    Press the space bar to activate the button with the focus.



Settings Menu

Seek Play Menu
When this menu item is checked, the video will be played by seeking each frame rather than 
by just playing it normally.    The file will be played as close to the selected frame rate as 
possible, but given that this method is slower, it may not be able to attain it.    If the step rate 
is greater than one, this menu item is automatically checked because a video cannot be 
played normally while stepping over frames.    The advantage of Seek Play is that no frames 
will be skipped, whereas in normal play mode (Seek Play not checked), frames may be 
skipped to maintain the chosen frame rate.    Please note that when playing a video backwards
in normal mode, only the keyframes will be shown.    This is fine for video files where every 
frame is a keyframe.    However, if you need to view intermediate frames between keyframes in
other files, Seek Play must be used.

Mouse:
Click "Settings" on the menu bar and then select "Seek Play".

Keyboard:
Press Ctrl-F1 or Press Alt-S for the Settings menu and then "S".

Reverse Play Menu
When this menu item is checked, the video will be played backwards.    Otherwise, it will be 
played forwards.    When this menu item is selected, the frame rate in the FPS text box is 
negated to reflect the change in direction.    The frame rate slider knob position is also 
adjusted.

Mouse:
Click "Settings" on the menu bar and then select "Reverse Play".

Keyboard:
Press Ctrl-F2 or Press Alt-S for the Settings menu and then "R".



Sequence Files Menu
When this menu item is checked, all the selected files in the File List Box will be played in 
sequence.    Otherwise, only the current file will be played.

Mouse:
Click "Settings" on the menu bar and then select "Sequence Files".

Keyboard:
Press Ctrl-F3 or Press Alt-S for the Settings menu and then "Q".

Loop Files Menu
When this menu item is checked, the selected video will continue to play over and over until 
the Pause Button is pressed.    If the video is playing forwards, it will jump back to the IN 
frame and repeat when it reaches the OUT frame.    If the video is playing backwards, it will 
jump back to the OUT frame and repeat when it reaches the IN frame.    If more than one file is 
selected and sequential playback mode is selected, then all the selected files will play before 
repeating.

Mouse:
Click "Settings" on the menu bar and then select "Loop Files".

Keyboard:
Press Ctrl-F4 or Press Alt-S for the Settings menu and then "L".

Show Full Screen Menu
When this box is checked, the video will be scaled to fill the screen with no border.    
Otherwise, it will appear inside a window.

Mouse:
Click "Settings" on the menu bar and then select "Show Full Screen".

Keyboard:
Press Ctrl-F5 or Press Alt-S for the Settings menu and then "F".

Constant Aspect Ratio Menu
When this menu item is checked, the video will maintain its width:height ratio, stored in the 
file, regardless of how the display window is resized.    The video will also maintain the same 
aspect ratio when playing in full screen mode.    If this box is unchecked, the video will be 
stretched to fill the window or the full screen.

Mouse:
Click "Settings" on the menu bar and then select "Constant Aspect Ratio".



Keyboard:
Press Ctrl-F6 or Press Alt-S for the Settings menu and then "A".

Use Constant Settings Menu
When this menu item is checked, the frame rate, step size, sound, volume, and seek mode will
stay the same from one video to the next during Sequencial playback regardless of the file 
settings.

Mouse:
Click "Settings" on the menu bar and then select "Use Constant Settings".

Keyboard:
Press Ctrl-F7 or Press Alt-S for the Settings menu and then "T".

Use Constant Display Menu
When this box is checked, the display size and aspect ratio setting will stay the same from 
one video to the next during Sequencial playback regardless of the file settings.    Otherwise, 
each file will be sized according to its stored size (except when in Full Screen mode).

Mouse:
Click "Settings" on the menu bar and then select "Use Constant Display".

Keyboard:
Press Ctrl-F8 or Press Alt-S for the Settings menu and then "D".



Frame Rate Slider
This slider is used to adjust the video frame rate from -80 (reverse play) and 80 (forward play) 
frames per second (fps).    Near the midpoint, the frame rate becomes fractional.    A /4 
indicates a frame rate of 1/4 fps or 4 seconds per frame (spf).    A video's initial frame rate is 
stored in the video file.    If the frame rate is set to zero, the video will stop.    However, if the 
slider is moved without shifting focus to another control, the video will start playing again 
without pressing the play button.    When playing the video with a step rate of one when seek 
play mode is off, frames may be skipped to maintain the chosen frame rate.    If the video is 
played with a step size greater than one or seek mode is on, no frames are skipped.    If the 
video is complex or your computer is slow, the video may not play at the specified frame rate.

Mouse:
Click on the slider knob and drag to change the frame rate.    Clicking to the left or right of the knob 
changes the frame rate by 10 units (10 fps or 10 spf, depending on knob location).

Keyboard:
When the slider has the focus, the up and down arrow keys change the frame rate by one unit (1 fps 
or 1 spf).    The Page Up and Page Down keys change the frame rate by 10 units.    The Home and 
End keys set the frame rate to -80 or 80 fps.    The Shift-Space key combination resets the frame rate
to its original value.



Frame Slider
This slider is used to move through the frames of a movie file.    The slider handle also moves 
as the movie is being played or stepped through using the "VCR" buttons below.

Mouse:
Click on the slider handle and slide it left or right while still depressing the button. The movie will be 
positioned accordingly.    Clicking to the left or right of the handle will step backwards or forwards 
about 1/20 of the length of the movie.

Keyboard:
When the slider has the focus, the left and right arrow keys will step backwards and forwards one 
frame at a time.    Page-Up and Page-Down will step backwards and forwards about 1/20 of the 
length of the movie.    Home and End will move to the current IN and OUT frames, respectively.



Step Size Slider
This slider is used to set a step rate, in frames, for the video.    It can range in value from 1 to 
the number of frames in the video.    When playing the video, it will jump the specified number
of frames as it plays.    The StepBack and StepForward buttons will move backwards and 
forwards by the specified number of frames.    Setting the step rate to something other than 
one will automatically cause the Seek Play menu item to become checked.

Mouse:
Click on the slider knob and drag to change the step size.    Clicking to the left or right of the knob will
change the step size by about 5% of the number of frames in the video.    Holding the Shift key down 
while clicking within on the boundary of the slider control will reset the step size to one.

Keyboard:
When the slider has the focus, the up and down arrow keys can be used to decrement or increment 
the step size by one.    The Page Up and Page Down keys can be used to decrement or increment 
the step size by about 5% of the total frames in the video.    The Home and End keys can be used to 
set the size to 1 or the number of frames in the video.    The Shift-Space key combination will reset 
the step size to one.



Volume Slider
This slider is used to change the volume.    It only works if the Sound check box is checked.

Mouse:
Click on the slider handle and slide it left or right while still depressing the button. The volume will be 
set accordingly.    Clicking to the left or right of the handle will decrease or increase the volume 
setting by 1/10 of the entire scale.

Keyboard:
When the slider has the focus, the left and right arrow keys will decrease or increase the volume in 
very small increments.    Page-Up and Page-Down will decrease or increase the volume setting by 
1/10 of the entire scale.    Home and End will set the volume to zero and maximum, respectively.



Frame Rate Field
This field is used for displaying and changing the video frame rate in frames per second (fps).
It can range in value from -80 (reverse play) to 80 (forward play).    A slash indicates fractional 
frame rates.    Thus, /4 indicates 1/4 fps or 4 seconds per frame (spf).    The initial frame rate is 
stored in the video file.    If the frame rate is set to zero, the video will stop.    However, 
pressing a key without shifting focus to another control allows the video to start playing 
again without pressing the play button.    When playing the video with a step rate of one when 
seek play mode is off, frames may be skipped to maintain the chosen frame rate.    If the step 
size is greater than one or seek play mode is on, no frames are skipped.    If the video is 
complex or your computer is slow, the video may not play at the specified frame rate.

Mouse:
The mouse can only be used to set the focus on the Frame Rate Field.    If you want to use the 
mouse, use the Frame Rate Slider.    Shift-clicking within the field will reset the frame rate to its 
original value.

Keyboard:
When the field has the focus, the up and down arrow keys change the frame rate by one unit (1 fps 
or 1 spf).    The Page Up and Page Down keys change it by 10 units.    The Home and End keys set 
the frame rate to -80 or 80 fps.    The Shift-Space key combination resets the frame rate to its original
value.



Step Size Field
This field is used for displaying and changing the step size, in frames, for the video.    It can 
range in value from 1 to the number of frames in the video.    When playing the video, it will 
jump the specified number of frames as it plays.    The StepBack and StepForward buttons will
move backwards and forwards by the specified number of frames.    Setting the step rate to 
something other than one will automatically cause the Seek Play menu item to become 
checked.

Mouse:
The mouse can only be used to set the focus on the Step Size Field.    If you want to adjust the step 
size using the mouse, use the Step Size Slider.    Holding the Shift key down while clicking within the 
field will reset the step size to one.

Keyboard:
When the field has the focus, the up and down arrow keys can be used to decrement or increment 
the step size by one.    The Page Up and Page Down keys can be used to decrement or increment 
the step size by about 5% of the total frames in the video.    The Home and End keys can be used to 
set the size to 1 or the number of frames in the video.    The Shift-Space key combination will reset 
the step size to one.



Whats This Help (?) Menu

Whats This Help (?) Menu
Selecting this menu item turns on pop-up help mode.    The pointer will change into a 
combination arrow and question mark.    Move the pointer over the control you want help for 
and then click again.    A pop-up window will appear with information about what the control 
does and how to use it.    To make the pop-up window go away, click within its boundaries.    
(NOTE: Help cannot be obtained on a control that is ghosted.)

Mouse:
Click "?" on the menu bar to activate help mode.    Next, click on the control you want help with.

Keyboard:
Press Alt-? and then use the mouse to click on the control you want help with.



Window Menu

Full Size Control Panel Menu
Selecting this menu item toggles the size of the control panel window.    When the item is 
checked, the entire control panel is shown.    When this item is unchecked, only the top half of
the panel is shown.    The file list and the file manipulation buttons to its right will not be 
shown.

Mouse:
Click "Window" on the menu bar and then select "Full Size Control Panel".    Alternatively, double-
click within the control panel window anywhere there is not an interface control.

Keyboard:
Press F2 or Press Alt-W for the Window menu and then "F".

Hide Control Panel Menu
Selecting this menu item hides the control panel window.    This can only be done when a 
video window is open.    The same effect can be had by simply clicking on an open video 
window.    Clicking on the video window while the control panel is hidden causes it to 
reappear.

Mouse:
Click "Window" on the menu bar and then select "Hide Control Panel".    Alternatively, click within a 
video display window.

Keyboard:
Press F3 or Press Alt-W for the Window menu and then "H".

Reset Size of Video Display Menu



Selecting this menu item resizes the windowed video display to the actual size of the 
currently open file.    This can also be accomplished by double-clicking within the video 
window itself.    (NOTE: This item has no effect on a full screen display.)

Mouse:
Click "Window" on the menu bar and then select "Reset Size of Video Display".    Alternatively, 
double-click within a video display window.

Keyboard:
Press Ctrl-R or Press Alt-W for the Window menu and then "R".

Show File Settings Menu
Selecting this menu item opens another window that shows all the current file settings as 
they would be saved to a settings file.    The data is displayed in spreadsheet format.

Mouse:
Click "Window" on the menu bar and then select "Show File Settings".

Keyboard:
Press Ctrl-T or Press Alt-W for the Window menu and then "S".



How to Order
<Order>
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